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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
______________________________________________________________________________ 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
 
______________________________________________________________________________ 
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This section describes the features of the RTM-LT16 Alcoa 
(Borden's) Light Tester mechanical reject control package. This 
includes the functional description, alarms detected, etc.  
 
________________________________________________________ 
1.1 FEATURES 
 
• Replaces the existing Hyde Park electronic reject control system 

as a complete retrofit / upgrade control package for the existing 
odd/even mechanical reject control.  

 
• Performs high speed control functions of Alcoa Light Tester to 

speeds in excess of 3000 CPM (machine mechanically 
permitting). This includes detection of leaker cans (interfaces with 
existing Leak detection arrays), odd/even can reject, alarm 
detection and data acquisition. 

 
• Two optional auxiliary reject inputs for use with Vision inspection 

systems. 
 
• Alarm detection:  

1. Leak Detection Array Fault 
2. Reset Timing Fault 
3. Clock Timing Fault 

 
• Data Acquisition (for both the current and previous shift):  

1. Total Good Cans 
2. Total Rejects 
3. Total Leaker Rejects 
4. Total Array Faults 
5. Aux1 (Vision Inspection) Rejects 
6. Aux2 (auxiliary fault input) Rejects 
7. Total Rejects per Pocket (1-16) 
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• Built-in 2 Line X 40 character sealed display with 24 key 
membrane keypad allows viewing of collected data, as well as, 
setup of all user variables (passcode protected or key switch 
enabled). 

 
• Interfaces directly to existing “Clock” and “Reset” timing inputs, 

driven off a two-channel shaft encoder (mounted to the main 
carrier wheel shaft) or sensors mounted inside the machine. 

 
• Interfaces directly with existing Leak Detection Array Receiver, 

Array Fault Receiver and Run Relay. 
 
• Based on high performance M4500 PLC/PLS, allowing easy 

trouble-shooting and user customization using SYSdev Program 
Development software. 

 
 
________________________________________________________ 
1.2 GENERAL DESCRIPTION 
 
The RTM-LT16 Alcoa (Borden's) Light Tester reject control package 
is an electronic retrofit upgrade for the MD-7, MD-10 and MD-16 
micro controller based high speed interface boards designed by Hyde 
Park Electronics for use on the LT family of light testers. It 
continuously monitors the operation of the array heads and controls 
the reject of defective cans. 
 
The existing counters and indicators are replaced with a 
Keypad/Display for operator interface and to display production data 
or adjust setup parameters. 
 
The system receives the following input signals from the tester and 
the existing control system: 
• Clock Timing pulse (one pulse per pocket). 
• Reset Timing pulse (one pulse per revolution of the main carrier 

wheel) 
• Array Reject Receiver 
• Array Fault Receiver 
• Two optional auxiliary fault inputs (Aux1 and Aux2) 
• Fault reset input 
• Machine Run input 
• End of Shift data transfer input 
• Setup Enable input 
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All inputs are 10-30VDC differential inputs, which can be wired as 
either sinking or sourcing. 
 
The system generates the following output signals to the tester and the 
existing control system: 
• Even Reject solenoid 
• Odd Reject solenoid 
• Run Relay 
• Good Can count pulse 
• Leaker Reject count pulse 
• Array Fault output 
• Aux1 Reject count pulse 
• Aux2 Reject count pulse 
• Rejects per Pocket count pulse (1-16) 
 
All outputs are 10-30VDC sinking outputs. 
 
The individual ON/Off status of each I/O point is indicated with 
LED’s located on the front of the board. The LED’s provide the status 
of the actual I/O point (field side) rather than the internal logic status.  
 
Input, output and user power wiring is implemented with a removable 
18-pin field wiring connector, allowing for easy board replacement. 
 
All alarms (when generated) extinguish the Run Relay output and are 
displayed on the front of the Keypad/Display. Either the Fault Reset 
input or use of the ESC key on the Keypad/Display will reset the 
alarm. 
 
Shift data is collected for both the current shift and previous shift and 
can be displayed on the Keypad/Display. Production count data is also 
available through discrete pulse count outputs to the host PLC. 
 
The package is not a dedicated "black box", but is instead 
implemented using the high performance Systems M4500 PLC/PLS 
module allowing easy customization by either SEA or the end user. 
The M4500 module is programmed using the DOS-based SYSdev 
Program Development software allowing the module to be 
programmed in any combination of Ladder or High-level (subset of 
"C"), as well as perform on-line monitoring and trouble-shooting. 
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The M4500 module incorporates a built-in PLS which interfaces 
directly with the optional machine-mounted resolver to provide all 
machine timing and eliminating the two-channel shaft encoder or 
other timing sensors. 
 
The M4500 is powered from 115-230 VAC, 50/60Hz, (1.2 Amps at 
115 VAC). The P4500 power supply produces +5 VDC and +/- 
12VDC for use by the M4500. The three S4569 digital DC I/O boards 
(as well as the Module Fault output) operate from +24 VDC. The 
+15VDC, 4 Amp DC power supply is used to supplement the +15 
VDC supplied by the Hyde Park MD interface board.  
 
 
________________________________________________________ 
1.3 ODD/EVEN REJECT SOLENOID CONTROL 
 
Mounted on the main carrier wheel are the array heads in 
combinations of 8, 10, 12 or 16. As the machine is rotated in the 
forward direction, Cans from the infeed star wheel are loaded onto the 
array head and carried through the test area and then unloaded onto a 
discharge star wheel.  
 
Just before a Can is loaded on the main carrier wheel the array head is 
checked by the Array Fault receiver to verify the operation of the 
Reject output. After a Can is unloaded from the main carrier wheel, 
the array head is exposed to ambient light and the reject output will be 
ON. If an array head fails to send a reject signal to the Array Fault 
receiver, an array head fault is generated, the run relay output is turned 
Off and reject information is shifted into a reject shift register. 
 
After a Can is loaded on the main carrier wheel, the array head passes 
a fixed light source that resets the reject circuit and enters the test 
area. At the end of the test area, the array head passes the Reject 
receiver where the reject output is checked. Reject information from 
the Reject receiver is stored and later shifted into a reject shift 
register. The Can is then loaded onto the discharge star wheel. 
 
The Clock timing, Reset timing, Reject, Array Fault, Aux1 and Aux2 
inputs are activated by signal transitions at their respective inputs. 
These are differential inputs and can be wired to be sensitive to 
transitions from high-to-low (sinking) or low-to-high (sourcing). At 
the transition of any of the reject fault inputs (Reset, Array Fault, 
Aux1 or Aux2), the states are latched in and then acted upon at the 
next leading edge transition of the Clock timing input.  
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The Reset timing input is used to determine the location of pocket 
number 1. The transition of this input resets the current pocket 
number count to 0. At the transition of the Clock timing input, the 
current pocket number is incremented by 1, as well as information 
regarding any of the reject inputs is shifted into their respective reject 
shift registers. In addition there is roll-over logic to limit the current 
pocket count to number of pockets of the machine. If a roll-over 
condition were to occur then a reset timing fault would be generated. 
 
The length of any of the four reject shift registers is variable and can 
be set to any value from 0 to 29. The length is used to establish the 
number of pocket delays for the activation of the reject solenoids. The 
Odd reject solenoid is activated for rejects from odd numbered 
pockets and the Even reject solenoid is activated for even numbered 
pockets. The outputs will remain active for a minimum of two 
pockets. 
 
All data collection counts are updated on the leading edge transition 
of the Clock timing input. 
 
Optionally, the machine can be fitted with a resolver, mounted to the 
main carrier wheel to provide all machine timing functions. This 
would replace the two-channel shaft encoder or timing sensor inputs.
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_______________________________________________________ 
1.4 DATA COLLECTION 
 
The following data is collected for both the current shift and the 
previous (last) shift: 
 

1) Total number of Good Cans tested 
2) Total number of Cans rejected 
3) Total number of Leaker rejects 
4) Total number of Array Faults 
5) Total number of Aux1 rejects 
6) Total number of Aux2 rejects 
7) Total leaker rejects per pocket (for each pocket) 

 
This data can be viewed locally on the display. This information is 
updated ("current" shift transferred to "Last" shift) based on the 
change of state of the End of Shift discrete input. This input can be 
activated on an 8 or 12 hour shift basis or alternatively activated 
manually on a label run basis depending on the user's preference. This 
data is also available to the host PLC via discrete pulse count outputs. 
 
In addition to the shift data collection, a separate buffer is available to 
collect rejects per pocket counts as a diagnostics aid to the operator 
for trouble-shooting a bad seal on a specific pocket. Unlike the shift 
data, these counts can be reset manually as necessary.  This allows the 
operator to note an abnormally high count on a specific pocket, 
attempt to correct the problem, reset the counts and then recheck the 
counts at a later time to determine if the problem still persists.  
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_______________________________________________________ 
1.5 ALARM DETECTION 
 
The package detects the following alarms: 
 
Leak Detection Array Head Fault: At the leading edge transition 
of the Clock timing input, a check is done to verify the transition of 
state of the Array Fault receiver. If a transition of state was not 
detected, the following sequence of events occurs: 
1. A “Leak Detection Array Head Fault” is generated 
2. The output for the Run Relay is turned Off  
3. The “Array Head Fault” output is turned ON 
4. A message is displayed on the Keypad/Display indicating the array 

head number that caused the fault 
5. Reject information is shifted into a reject shift register to activate 

the appropriate reject solenoid to reject the associated can. 
 

Reset Timing Fault: At the leading edge transition of the Clock 
timing input, a check is made to verify the occurrence of the Reset 
timing input and to increment the current pocket count. If the current 
pocket count exceeds the number of pockets of the machine then a 
Reset Timing Fault is generated. 
 
The Reset timing input determines the location of pocket number 1 
and occurs once per revolution of the main carrier wheel in between 
Clock timing pulses. At the occurrence of the Reset timing input, the 
current pocket count is reset to zero. If a Reset Timing Fault is 
generated the following sequence of events occurs: 
1. The current pocket count resets to 1 
2. The output for the Run Relay is turned Off 
3. The associated fault message is displayed on the Keypad/Display 
 
Clock Timing Fault: After the machine starts and the Machine Run 
input is true, the system will periodically check for the occurrence of 
the Clock timing input approximately every 1.5 seconds. If this input 
fails to change state then a Clock Timing Fault is generated and the 
following sequence of events occurs: 
1. The output for the Run Relay is turned Off 
2. The associated fault message is displayed on the Keypad/Display 
 
Note: The transition of the Fault Reset input or the ESC key on the 
Keypad/Display can be used to reset any of the faults.
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The RTM-LT16 is mounted on the inside the existing control cabinet 
of the tester and replaces the MD micro controller high speed 
interface board designed by Hyde Park Electronics. 
 
 
________________________________________________________ 
2.1 WHAT'S INCLUDED 
 
Verify that the following items are included when unpacking the 
RTM-LT16: 
 

1ea. P4500 Power Supply 
1ea.  M4500 PLC/PLS with associated I/O boards (3 - S4569 

DC In/Out Sinking) 
1ea.  15 V DC Power Supply unit 
1ea. RSV34-MS1 Resolver (optional) 
1ea. RSV-RSCBLE-100 Resolver cable (supplied with resolver 

option) 
1ea. RTM-LT16 User's Manual 
1ea. M4500 User's Manual 
1ea. RTM-LT16 Program Disk 

 
 
________________________________________________________ 
2.2 SERVICES REQUIRED 
 
Electrical Power: 
The RTM-LT16 is powered from 115VAC/230VAC 50/60HZ at 
2.8/1.5 Amps and +24VDC at 2.0 Amps. The 115VAC/230VAC is 
used to power the P4500 power supply and the +15 V DC power 
supply, while the +24VDC is used to power the +24VDC I/O (sensors 
and reject solenoids). The +24VDC current required by the RTM-
LT16 is no more than the existing Hyde Park +24VDC current 
requirement, therefore the existing +24VDC power supply should be 
adequate. 
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________________________________________________________ 
2.3 INSTALLATION 
 
The following must be performed with the machine stopped and 
power “off”. Thus this is usually performed on a scheduled 
maintenance day. 
 
1) Disconnect all wires and remove existing Hyde Park MD micro 

controller high speed interface board. 
 
2)  Mount the D4591 Keypad/Display on the front of the operator 

console in an area approximately 9-1/2 by 6 inches. The 
Keypad/Display replaces existing reject counters and rejected 
pocket displays 

 
3) Route the display cable from the back of the Keypad/Display to 

the M4500 PLC/PLS and connect to the underside of the rack. 
 
4) Mount the P4500 power supply and the M4500 PLC/PLS in a 7-

1/2 by 9-1/8 inch opening inside the operator console. 
 
5) Mount the 15 VDC power supply to DIN Rail with an 

approximate opening of 3 inches. 
 

6) Mount the RSV34-MS1 resolver (if purchased), with provided 
bracket, to the main carrier wheel or discharge star wheel shaft.  
 
Note: Resolvers are very noise sensitive. Be sure to keep the 
cable away from sources of high voltage as it is routed to the 
M4500. The resolver provides all the timing related functions of 
the machine. Therefore the two channel shaft encoder or timing 
sensors are no longer needed and can be removed. 
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Wiring:  
Refer to the electrical control schematic provided with this manual. 
Wires from the old control board may not reach terminals on the 
M4500 and may need to be extended or replaced. 
 
Note: All inputs are 10-30VDC differential inputs and can be wired 
as either sinking or sourcing. All outputs are 10-30VDC sinking 
outputs (see wiring schematic for more detail). 
 
Inputs: 
1) Terminate wires for the Reject receiver (IN0) and Array Fault 

receiver (IN1).  
 
2) Terminate wires for the Clock and Reset timing inputs (B100.0 

and B100.1 respectively). These inputs can be derived from a two 
channel shaft encoder driven off the main carrier wheel or from 
sensors located inside the machine. The Clock timing occurs once 
per pocket. The Reset timing occurs once per revolution of the 
main carrier wheel, in between Clock timing pulses and 
determines the location of pocket 1. 

 
3) Terminate wires for Aux1 (B100.2, vision system reject) and 

Aux2 (B100.3, optional, if used). 
 
4) Terminate wires for the Fault Reset input (B110.0). 
 
5) Terminate wires for the Machine Run (RR) input (B110.1). This 

signal should be ON when the main drive is enabled (running) and 
Off when the drive is disabled (not running). This signal can be 
derived from the main PLC logic and wired directly from an 
existing spare output. 

 
6) Terminate wires for the End of Shift input (B110.2, optional). 

This signal can be wired from an existing spare output or from a 
momentary push button. The 0 to 1 transition of this input can be 
at the end of either an 8 or 12 hour shift or alternatively at label 
changes such the data collected would be for label runs rather than 
complete shifts. 

 
7) Terminate wires for the Setup Enable input (B110.3, optional). 

This is generally wired form a key switch (if desired) to allow 
entry to setup variables through Keypad/Display without a 
passcode entry. 
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Outputs: 
1) Terminate wires for the Even (B101.0) and Odd (B101.1) reject 

solenoids. 
 
2) Terminate wires for the Run Relay (B101.2). This output will turn 

Off whenever any of the following faults are present: 
a) Leak Detection Array Fault 
b) Reset Timing Fault 
c) Clock Timing Fault 

 
3) Terminate wires for the Module Fault Output (FLT). The M4500 

contains comprehensive fault detection routines that verify the 
proper operation of the module at all times. If the module detects a 
fault condition, the "FLT" LED on the front of the module is 
illuminated. When a fault is detected, the following fault routine is 
executed:  
1. User program execution is suspended.  
2. "FLT" LED on the front of the module is illuminated.  
3. "RUN" LED is extinguished.  
4. Fault interlock is opened. 
5. Fault code representing the detected fault is saved in internal 

memory of the module for viewing with setup program. 
 
4) Terminate wires for the Array Fault output (B101.5). This output 

is ON (maintained) whenever an Array Head fault is generated 
and Off once the fault is reset through the Fault Reset input or by 
pressing the ESC key on the Keypad/Display. 

 
5) Terminate wires for the production (pulse) count outputs: 

1. Good Can count (B101.3) 
2. Leaker Reject count (B101.4) 
3. Aux1 (Vision) Reject count (B101.6) 
4. Aux2 Reject count (B101.7) 
5. Reject Per Pocket counts (1 – 16) 

 
These outputs are triggered off of the Clock timing input and are 
on for approximately the same period as the Clock timing signal is 
true. 
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________________________________________________________ 
2.4 SETUP 
 
Once power is re-applied to the system and the I/O is verified, 
perform the following to set the parameters of the RTM-LT16. Refer 
to section 3, “Using the Keypad Display”, for details of display menus 
and key sequences used to set the parameters. 
 
Internally, the RTM-LT16 maintains four independent reject shift 
registers, one for each type of reject (leaker reject, array fault, Aux1 
(vision) reject and Aux2 reject). Reject information is shifted into the 
reject shift registers at the leading edge of the Clock timing input. 
Reject information must be sampled ahead of the Clock timing input. 
 
1) To start with, set the number of pockets of the machine (8, 10, 12 

or 16).  
 
2) Set the “Resolver Input Enable (0 = No, 1=Yes)”. For machines 

that have installed a resolver for machine timing, set this value to 
1 to enable resolver feedback. 

 
3) Initially set the “Pocket Number 1 Offset” and the “Array Head 

Offset” to 0. 
 

4) The reject shift settings establish the number of pocket delays 
between the recording of the reject and the activation of the reject 
solenoid. Initially set the reject shifts as follows: 
• Reject Receiver Shifts (0-29):  2 
• Array Fault Receiver Shifts (0-29):  4 
• Aux1 Reject Input Shifts (0-29):  2 
• Aux2 Reject Input Shifts (0-29):  2 

 
5) When a shaft mounted resolver is not used, the machine is 

electronically timed by rotating the shaft encoder (or adjusting the 
Clock timing sensor) such that the Clock pulse input turns ON 
when the reject mechanism must operate. The Reset timing must 
be positioned such that it comes ON in between Clock timing 
pulses. 
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6) When a resolver is mounted to the shaft of the main carrier wheel 
(or discharge star wheel), the M4500 internally generates the 
Clock timing (one pulse per pocket) and the Reset timing (one 
pulse per revolution of the main carrier wheel). Perform the 
following when a resolver is installed for machine timing: 

 
a. Verify the direction of rotation of the resolver. By hand, move 

the tester forward and verify the absolute position counts up 
from 0 through 3839 as the main carrier wheel makes one full 
revolution. If not, swap S1 and S3 at the resolver connector. 

 
b. The resolver is timed by rotating the machine forward until a 

reject from pocket 1 will activate the Odd reject solenoid. This 
is the resolver “Zero” position. 

 
c. Verify 360 degrees per pocket. Position the machine at 0 

degrees. By hand, move the machine forward one pocket. The 
relative position of the machine (POS 360) should count up 
thru 359 and again be at 0 degrees. Do this for all the pockets.  

 
Note: The position may deviate +/-20 degrees from pocket to 
pocket. This is normal and is not a problem. If it does deviate 
significantly more than +/-20 degrees, something is wrong 
with the resolver or resolver wiring (refer to section 5.2, to 
trouble-shoot). 

 
7) Set the “Reject Receiver Shifts”. From the infeed, feed a can, with 

a big hole in it, into the machine. Rotate the machine forward until 
the pocket with this can turns ON the Reject Receiver input (IN0). 
Continue to rotate the machine forward until the “Clock” timing 
input just turns ON or POS 360 reads “000” and count this as “0”. 
Move the machine forward one pocket to the Clock timing 
position, count this as “1”. Continue doing this until the can is at 
the point where the reject mechanism must operate. Whatever the 
“count” is at this point is the number entered into the “Reject 
Receiver Shifts”.  

 
8) Set the “Aux1 Reject Input Shifts” (vision system reject input) and 

“Aux2 Reject Input Shifts” to the same number as the “Reject 
Receiver Shifts”. 
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9) Set the “Array Fault Receiver Shifts”. At the leading edge 
transition of the Clock timing input, a check is done to verify the 
transition of state of the Array Fault receiver. If a transition of 
state was not detected an “Array Head Fault” is generated and 
reject information is shifted into a reject shift register. Using 
electrical tape, cover the “Reject” IR output of array an array head. 
This will cause an “Array Head Fault” to be generated on the 
particular pocket.  

 
Rotate the machine forward and feeding cans into the machine 
until the array head with the covered reject output just passes the 
“Array Fault” receiver. Continue to rotate the machine forward 
until the “Clock” timing input just turns ON or POS 360 reads 
“000” and count this as “0”. Move the machine forward one 
pocket to the Clock timing position, count this as “1”. Continue 
doing this until the can associated with the faulted array head is at 
the point where the reject mechanism must operate. Whatever the 
count is at this point is the number entered into the “Array Fault 
Receiver Shifts”. 

 
For the remainder of the setup, the machine needs to be run in normal 
production. 
 
WARNING: Until the setup is complete, bad cans and calibrated 
test cans may go down the line. 
 
With the machine running and feeding cans, perform the following. 
 
10) Press the “Test Reject” key and verify one can is cleanly rejected. 
 
11) Verify a calibrated leak can is correctly rejected. If not adjust the 

“Reject Receiver Shifts” parameter until it is. 
 
12)  If the tester is equipped with a vision system, verify the input 

position of the Aux1 (vision) reject signal. This position must not 
be within +/-60 degrees of the “Clock” timing. Run a visually 
defective can through the machine and verify that the vision test 
can is correctly rejected.  

 
Note:  Depending on where the vision system reject signal is 
received, the “Aux1 Reject Input Shifts” may have to be adjusted 
until the correct can is rejected. 
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13) Verify the “Pocket #1 Offset”. Cover the “Array Reset” pickup 
(center window of array head) for array head number 1 with 
electrical tape. Run cans through the machine and observe the 
pocket number of the Last Reject. A can from pocket #1 should be 
rejected every revolution of the main carrier wheel. Adjust the 
“Pocket #1 Offset” until rejects for pocket number 1 is 
continuously incrementing then remove the tape from the array 
head. 

 
14) Verify the “Array Fault Offset” parameter.  Cover the “Reject” IR 

output of array head number 1. This will cause an “Array Head 
Fault” to be generated on array head number 1.  Jog the machine 
through several revolutions. A “Leak Detection Array Fault” 
alarm will be generated with the corresponding array head number 
indicated on the Keypad/Display. Reset the alarm, adjust the offset 
and jog the machine again.  Continue adjusting this parameter 
until array head number 1 is displayed then remove the tape from 
the array head. 

 
The setup is now complete. If problems are in countered in any of the 
previous setup steps, refer to the trouble-shooting section 5.2.  Once 
all the parameters are set as required, upload and save them to disk 
using the “RTMLT16” setup program (see section 4.2.2 –Upload 
(Save) Data). 
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________________________________________________________ 
2.5 RTMLT16 SETUP SOFTWARE INSTALLATION 
 
Follow the steps below to install the RTMLT16 setup software 
application program onto a computer that will be used to support the 
system. The Windows based RTMLT16 setup program is compatible 
with Windows 95, 98, NT, ME, 2000 and XP. 
 
The setup software is used to interface to the M4500, tune (setup) the 
user adjustable variables of the RTM-LT16, save setup variables to 
disk and view production count data. 
 
Run the “setup.exe” file located in the root directory of the supplied 
program disk. This will initiate the installation process. Follow the 
onscreen instructions to complete the installation. 
 
If any problems are incurred during the installation process, try 
restarting your computer and running “setup.exe” again.  Make sure 
all programs have been exited prior to installation. 
 
 
________________________________________________________ 
2.6 SYSdev2000 PROGRAM DEVELOPMENT SOFTWARE 
INSTALLATION 
 
The SYSdev2000 Program Development software is an optional 
software package used to perform on-line trouble-shooting and 
program modifications. If SYSdev2000 was purchased with the RTM-
LT16 package and is not already installed on the your computer, run 
the “setup.exe” file located in the root directory of the supplied 
program disk. This will initiate the installation process. Follow the 
onscreen instructions to complete the installation.  
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________________________________________________________ 
2.7 RTMLT16 APPLICATION PROGRAM INSTALLATION 
 
The RTMLT16 application program is a SYSdev based program, 
loaded into the M4500 PLC/PLS. The application program is written 
in a combination of High-level (subset of C) and Ladder logic.  
 
If the user desires to make program changes or perform on-line 
monitoring of the program execution, the files, which constitute the 
application program, will have to be loaded onto the hard drive of the 
computer used to support the system. The SYSdev2000 Program 
Development Software will also have to be installed. 
 
Located on the supplied program disk is the RTMLT16 folder. This 
folder contains the source code files for the application program. 
Simply copy this folder to the hard drive of the computer used to 
support the system.  
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________________________________________________________ 
2.8 MODIFY EXISTING PLC PROGRAM 
 
The RTM-LT16 replaces the existing Hyde Park electronic reject 
control system as a complete retrofit / upgrade control package for the 
existing odd/even mechanical reject control. Modify the logic of the 
existing control system PLC program to interface with the RTM-
LT16, incorporating the following into the existing PLC ladder logic: 
 
Note: All inputs to the M4500 are 10-30VDC differential inputs and 
can be wired as either sinking or sourcing. All outputs from the 
M4500 are 10-30VDC sinking outputs (see wiring schematic for more 
detail). 
 
1) Add the "Module Fault Output" interlock as an input to the PLC. 

If a fault condition is detected, the "FLT" LED on the front of the 
module is illuminated, the application program execution is 
suspended and the Fault interlock is opened. The fault code 
representing the detected fault is saved in internal memory of the 
module for viewing with setup program. 

  
2) Add the "Machine Run" output to the PLC logic. This should be 

ON when the drive is enabled (running) and should be "off" when 
the drive is disabled (not running). This is also true for jog mode. 

 
3) Add the optional “End of Shift” output to the PLC logic. The 0 to 

1 transition of this input transfers the “Current” shift data to the 
“Last” or previous shift data. This can be at the end of either an 8 
or 12 hour shift or alternatively at label changes such the data 
collected would be for label runs rather than complete shifts. 

 
4) The existing numeric data displays can be optionally removed as 

all production counts and reject information can be viewed on the 
Keypad/Display. All production data is available to the host PLC 
from pulsed outputs. This includes: 
• Good Can counts 
• Leaker, Aux1 and Aux2 reject counts 
• Rejects per Pocket counts (1-16) 

 
Add these as inputs to the PLC for data collection as necessary. 
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________________________________________________________ 
2.9 SETUP REFERENCE 
 
The following sections are provided as a reference to setup operations 
performed in section 2.4. 
 
________________________________________________________ 
2.9.1 DEFAULT SETUP VARIABLES 
 
The following are the default parameters for the LT-8 Tester 
 
Reject Shift Registers: 
 Pocket #1 Offset (for rejected pocket Counts)  : 0 
 Array Head Fault Offset (for array head fault display)  : 0 
 
 Reject Receiver Shifts (0-29)  : 2 
 Array Fault Receiver Shifts (0-29)  : 4 
 Aux1 (vision) Reject Input Shifts (0-29)  : 2 
 Aux2 Reject Input Shifts (0-29)  : 2 
 
 
The following are the default parameters for the LT-10 Tester 
 
Reject Shift Registers: 
 Pocket #1 Offset (for rejected pocket Counts)  : 0 
 Array Head Fault Offset (for array head fault display)  : 0 
 
 Reject Receiver Shifts (0-29)  : 2 
 Array Fault Receiver Shifts (0-29)  : 4 
 Aux1 (vision) Reject Input Shifts (0-29)  : 2 
 Aux2 Reject Input Shifts (0-29)  : 2 
 
 
The following are the default parameters for the LT-12 Tester 
 
Reject Shift Registers: 
 Pocket #1 Offset (for rejected pocket Counts)  : 0 
 Array Head Fault Offset (for array head fault display)  : 0 
 
 Reject Receiver Shifts (0-29)  : 2 
 Array Fault Receiver Shifts (0-29)  : 4 
 Aux1 (vision) Reject Input Shifts (0-29)  : 2 
 Aux2 Reject Input Shifts (0-29)  : 2 
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The following are the default parameters for the LT-16 Tester 
 
Reject Shift Registers: 
 Pocket #1 Offset (for rejected pocket Counts)  : 0 
 Array Head Fault Offset (for array head fault display)  : 0 
 
 Reject Receiver Shifts (0-29)  : 2 
 Array Fault Receiver Shifts (0-29)  : 4 
 Aux1 (vision) Reject Input Shifts (0-29)  : 2 
 Aux2 Reject Input Shifts (0-29)  : 2 
 
 
________________________________________________________ 
2.9.2 MACHINE TIMING 
 
When a shaft mounted resolver is not used, the machine is 
electronically timed by rotating the shaft encoder (or adjusting the 
Clock timing sensor) such that the Clock input turns ON when the 
reject mechanism must operate. The Reset timing must be positioned 
such that it comes ON in between Clock timing pulses. 
 
When a resolver is used for machine timing, the M4500 internally 
generates the Clock timing (one pulse per pocket) and the Reset 
timing (one pulse per revolution of the main carrier wheel).  
 
Perform the following when a resolver is installed for machine timing: 
1. Time the resolver by rotating the machine forward until a reject 

from pocket 1 will activate the Odd reject solenoid. This is the 
resolver zero position. 

 
2. With the machine located at “Zero”, set the resolver offset through 

the setup menu of the Keypad/Display, “3: Zero Machine (Set 
Resolver Offset)” selection. 
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________________________________________________________ 
2.9.3 MACHINE TIMING SIGNALS 
 
Clock Timing: The Clock timing is generally derived from a two 
channel shaft encoder driven off the main carrier wheel. It can also be 
from a sensor located inside the machine. The Clock timing occurs 
once per pocket. When the machine is fitted with a resolver (replacing 
the shaft driven encoder or timing sensors) the M4500 internally 
generates the necessary Clock timing pulse required for reject control. 
 
Reset Timing: The Reset timing is generally derived from a two 
channel shaft encoder driven off the main carrier wheel. It can also be 
from a sensor located inside the machine. The Reset timing occurs 
once per revolution of the main carrier wheel, in between Clock 
timing pulses and determines the location of pocket 1. When the 
machine is fitted with a resolver (replacing the shaft driven encoder or 
timing sensors) the M4500 internally generates the necessary Reset 
timing pulse required for reject control. 
 
 
________________________________________________________ 
2.9.4 CRITICAL INPUT POSITIONS 
 
With a shaft mounted resolver installed and enabled for feedback, the 
“View Critical Input Positions” menu is used to view the input 
positions, (relative position in degrees, 360 degrees pocket to pocket 
reference) of the Reject Receiver, Array Fault Receiver, Aux1 (vision) 
and Aux2 reject signals. Primarily this is to verify that none of these 
signals are coincident with the “Clock” timing. The system could 
potentially miss clock the reject inputs causing the wrong Can to be 
intermittently rejected if these reject signals are too close to the 
“Clock” timing (approximately +/- 40 degrees). 
 
The “4: View Critical Input Positions” menu is accessed from the 
main Setup display menu. 
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________________________________________________________ 
2.10 M4500/P4500/D4591 INSTALLATION 
 
The following sections provide information on mounting and wiring 
the M4500, P4500 and D4591 as well as a description of the power-
up sequence. 
 
________________________________________________________ 
2.10.1 MOUNTING THE D4591 KEYPAD/DISPLAY 
 
The D4591 Keypad/Display is to be mounted to the outside of a 
cabinet door or operator console. Use the recommended cut-out in the 
figure below.  
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1. Remove the ribbon cable from the display.  
2. With the gasket installed on the mounting studs, slide the D4591 

into the cut-out from the front and attach with supplied hardware.  
3. Install the 26-pin polarized ribbon cable (the ribbon cable 

connector will mate with the display only one way).  
 

Note: Communications is parallel at TTL levels therefore the 
display must be placed in close proximity to the M4500 
(maximum cable length is 8 feet).  

 
4. Once installed, a lugged earth ground wire should be installed on 

one of the mounting screws to insure that the display is positively 
grounded. 

 
 
________________________________________________________ 
2.10.2 MOUNTING THE M4500 CHASSIS 
 
The chassis should be mounted using 4ea. 8-32 screws and lock 
washers. If the M4500 is to be connected to the D4591 
keypad/display, connect the ribbon cable for the display to the M4500 
display interface connector (bottom of chassis) prior to mounting the 
M4500 chassis. The ribbon cable connector is polarized and will mate 
with the M4500 display interface connector in only one way. Once the 
M4500 chassis is installed, a lugged earth ground wire should be 
installed on one of the mounting screws to insure that the chassis is 
positively grounded. 
 
 
________________________________________________________ 
2.10.3 MOUNTING THE P4500 POWER SUPPLY 
 
The P4500 power supply is mounted to the left of the M4500 chassis 
in close proximity to the chassis. Use 2ea. 8-32 screws and lock 
washers to mount the P4500. Once mounted, connect the power 
supply cable connector in the +5/C/+12/C/-12 connector of the 
M4500. The connector is polarized and will only mate one way. 
 
Wire 115VAC/230VAC 40-400HZ power to the P4500 power 
connector. The AC current rating is 0.5 amps at 115VAC and 0.3 
amps at 230VAC. 
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________________________________________________________ 
2.10.4 INSTALLING THE I/O BOARDS 
 
1) Remove the cover from the M4500 chassis (retained with three 

captive screws on the lower front of the cover and two captive 
screws on each side). 

 
2) Install the S4569 in Slot0-0 (furthest left slot) of the M4500 and 

set the slot address dip switches (SW1) to the following positions: 
 

Slot 0:  SW1 switch1 = "OFF" 
SW1 switch2 = "OFF" 

 
3) Install the S4569 in Slot0-1 (slot next to S4569 in Slot 0) of the 

M4500 and set the slot address dip switches (SW1) to the 
following positions: 

  
Slot 1:  SW1 switch1 = "ON" 

SW1 switch2 = "OFF" 
 
4) Install the S4569 in Slot0-2 (slot next to S4569 in Slot 1) of the 

M4500 and set the slot address dip switches (SW1) to the 
following positions: 

 
Slot 2:  SW1 switch1 = "OFF" 

SW1 switch2 = "ON" 
 
5) Install the OPTIONAL S4516 serial communications board in 

Slot0-2  (slot next to S4569 in Slot 2) and set the slot address dip 
switches (SW2) to the following positions: 

 
Slot 3:  SW2 switch1 = "ON" 

SW2 switch2 = "ON" 
 

Set the RS-232/RS-422 select dip switches (SW1) on the S4516 to 
the following positions (RS-232 selected): 

 
S4516:  SW1 switch1 = "ON" 

SW1 switch2 = "OFF" 
 
6) Install the cover back over the M4500, making sure all the board 

connectors protrude the slots in the cover. Tighten the three 
captive screws on the lower front of the cover and the two captive 
screws on each side of the M4500 chassis. 
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7) With power to the P4500 Off, install the P4500 power supply 
cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector on the cable is polarized and should mate with the 
connector on the M4500 only one way). 

 
8) Install the respective field wiring arms on all the I/O boards of the 

M4500 (I/O slots0 thru 2, resolver and IN0/IN1 connector). Make 
sure all field wiring connectors are fully mated in the M4500. 

 
 
________________________________________________________ 
2.10.5 APPLICATION PROGRAM DOWNLOAD 
 
The following is provided only as a reference. This step was 
performed at the factory prior to shipping. This step need only be 
performed in the event the M4500 is replaced. 
 
Once the M4500 is installed, perform the following to download the 
application program and setup data to the M4500: 

 
1) Power up the M4500 and the computer used to interface with the 

M4500 
 
2) Connect an RS-232 cable from the computer COM port to the 

"PROG" port on the M4500. 
 
3) Initiate the RTMLT16 Windows based setup program. 
 
4) Download the application program to the M4500 (see section 

4.2.3). 
 
5) Download the previously saved setup data to the M4500 (see 

section 4.2.4). 
 
6) The M4500 is now ready to run, loaded with the application 

program and setup data. 
 
Note:  Double check the machine zero position and re-zero the 
resolver if necessary, prior to running the machine. 
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The Keypad/Display of the RTMLT16 contains 24 keys consisting of 
data display commands, setup commands, a numeric keypad and a 2 
line by 40 character back-lit LCD display that displays the selected 
data and setup menus. The Keypad/Display is used to view data or to 
adjust setup parameters and zero the resolver. 
 
 

 
The Keypad/Display allows the following to be viewed or adjusted: 
 

1) Configure Machine 
2) Set Reject Shift Registers 
3) Set Machine Zero 
4) View Critical Input Positions 
5) View the Number of Rejects per Pocket 
6) View the Current Shift Data 
7) View the Last Shift Data 
8) Test the Reject Solenoids 

 
Note: For virtually all the menus, the "NEXT" and "PREV" keys can 
be used to advance to the next item of the menu or retard to the 
previous item on the menu. 
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________________________________________________________ 
3.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) 
contains the following data: 
 

SPEED (CPM):xxxx       LAST REJECT:xx 
GOOD CANS:x,xxx,xxx             REJECTS:xx,xxx 

 
Where the "Speed" is the current speed of the tester, the “Last Reject” 
is the pocket number of the last leaker reject, the "Good Cans" field is 
the total number of good cans tested so far into the current shift, and 
the "Rejects" field is the total number of cans rejected from the 
machine (scrap) so far into the current shift. This display effectively 
replaces a speed meter, and two can counters. This screen is always 
returned to when no commands are active. 
 
 
________________________________________________________ 
3.2 "REJECTS PER POCKET" KEY 
 
The Number of Rejects per Pocket menu is provided to aid in the 
trouble-shooting of a light seal problem with a pocket or pockets.  
 
The total number of leaker rejects for each pocket since the last reset 
or end of shift is displayed. These counts can be reset at any time to 
aid in the trouble-shooting process. The data is viewed by pressing 
this key. The display is a series of screens each with four pockets of 
data: 
 

-- DIAGNOSTICS (REJECTS PER POCKET) -- 
1:xxxx       2:xxxx        3:xxxx        4:xxxx 

 
Where the numbers 1 through 4 are the first 4 pockets and the "xxxx" 
would be the actual counts for the respective pockets. The user can 
advance to the next screen or retard to the previous screen by pressing 
the "NEXT" or "PREV" key respectively. 
 
The final screen prompts the user to reset the counts by pressing "0". 
If the counts are to be reset, press the "0" key, if not, press the "ESC" 
key. The default screen will then be displayed. 
 
The "ESC" key can also be used at any time to abort the rejects per 
pocket data display and return back to the default screen. 
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________________________________________________________ 
3.3 "CURRENT SHIFT" KEY 
 
The "Current Shift" key is used to view the current shift data. This 
data is the totals so far into the shift. This data is transferred to the 
"Last shift" data when the end of shift input transfers from a "0" to a 
"1". This can be at the end of either an 8 or 12 hour shift or 
alternatively could be done at label changes such that the data 
collected would be for label runs rather than complete shifts. This data 
is only reset at the transition of the "End of Shift" input.  
 
Note: The Current shift "Good Cans" and "Rejects" is displayed as 
part of the default screen. 
 
The Current Shift data is defined as follows: 
 
Good Cans: This is the total number of good cans tested so far into 
the shift. 
 
Rejects: This is the total number of cans rejected from the machine 
for the shift. 
 
Leaker Cans: This is total number of “Leaker” cans rejected from 
the machine for the shift. 
 
Array Faults: This is the total number of “Array Faults” that have 
occurred for the shift. 
 
Aux1 Rejects: This is the total number of cans rejected due to an 
Aux1 (vision system, if used) reject input for the shift. 
 
Aux2 Rejects: This is the total number of cans rejected due to an 
Aux2 (if used) reject input for the shift. 
 
Rejects per Pocket (1:-16:): This is the total “Leaker” rejects for 
each pocket. A disproportionately high count for a particular pocket 
would indicate a light seal problem for the pocket. 
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________________________________________________________ 
3.4 "LAST SHIFT" KEY 
 
The "Last Shift" data is identical to the current shift data except it is 
the totals for the previous shift or label run. This allows data 
collection and diagnostics to take place automatically over a “Two 
Shift” period.  
 
 
________________________________________________________ 
3.5 "SETUP" KEY 
 
This selection is used to invoke the primary setup menu. This consists 
of the following four selections: 
 
 1: CONFIGURE MACHINE 
 2: SET REJECT SHIFT REGISTERS 
 3: ZERO MACHINE (SET RESOLVER OFFSET) 
 4: VIEW CRITICAL INPUT POSITIONS 
 
Press the corresponding numeric key (1 to 4) to select the respective 
setup section. 
 
The "NEXT" and "PREV" keys are used to advance to the Next or 
Previous variable respectively. Enter the new value on the numeric 
keypad and press <ENTER> to change a value. The value will be 
entered and then advanced to the next variable automatically. The 
primary setup menu is returned to once the last variable is entered. 
Pressing <ESC> at anytime will exit back to the primary setup menu. 
 
Note:  The primary setup menu is passcode protected. A 5-digit 
passcode must be entered to gain access to the primary setup menu. If 
an incorrect passcode is entered, the message "INCORRECT 
PASSCODE" will be displayed. Passcode entry can be attempted 
again or press the <ESC> key to return to the main display. 
 
When a passcode is entered, the digits entered are not displayed. 
Instead "*" characters are displayed as each digit is entered. This 
prevents unauthorized personnel from observing the passcode as it is 
entered. In addition, the "ENTER PASSCODE" prompt is only active 
for a maximum of 60 seconds and then returned to the main display. 
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The "Setup Enable" input is used to bypass the “ENTER 
PASSCODE” prompt and gain access to the primary setup menu. If 
the input is Off, then the normal passcode prompt is displayed. A 
keyed switch can be wired to the "Setup Enable" input to enable this 
function when the input is ON. 
 
The 5-digit passcode can only be set using the RTMLT16 setup 
program. If the passcode is set to 0 then passcode entry completely 
disabled and immediate access to the setup parameters is granted. 
 
 
________________________________________________________ 
3.5.1 CONFIGURE MACHINE 
 
This menu is activated when the "1" key (CONFIGURE MACHINE) 
is pressed while the primary setup menu is active. The following 
parameters may then be adjusted or viewed: 
 
Machine Number of Pockets (8 to 16):  This parameter is used 
to set the number of pockets of the machine (8, 10, 12 and 16). Set 
this value to the number of pockets for the machine. 
 
Resolver Input Enable (0=No, 1=Yes):  This is used to enable 
the use of the resolver feedback for all timing functions. Enabling this 
feature allows additional setup menus and displays to be active as well 
as disable the inputs for the “Clock” and “Reset” timing. Set this 
value to a “1” when a resolver is used for machine timing. 
 
 
________________________________________________________ 
3.5.2 SET REJECT SHIFT REGISTERS 
 
This menu is activated when the "2" key (SET REJECT SHIFT 
REGISTERS) is pressed while the primary setup menu is active. The 
following parameters may then be adjusted or viewed: 
 
Pocket Number 1 Offset (0 to Number of Pockets-1): This is 
adjusted such that a reject from pocket #1 is counted as a reject from 
pocket #1. Covering the “Array Reset” pickup (center window of 
array head) of array head number 1 with electrical tape will create a 
consistent. Run cans through the machine and observe the pocket 
number of the Last Reject. Adjust the “Pocket #1 Offset” until rejects 
for pocket number 1 continuously increment. 
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Array Fault Offset (0 to Number of Pockets-1):  This number 
is used to correctly display the number of the “Faulted Array Head” 
when a “Leak Detection Array Fault” occurs. Using electrical tape, 
cover the “Reject” IR output of array an array head. This will cause an 
“Array Head Fault” to be generated on the particular pocket. Adjust 
this offset until the faulted array head is correctly displayed when the 
fault is generated. 
 
Reject Receiver Shifts (0-29): The length of this reject shift 
register can be set to any value from 0 to 29 and is used to establish 
the number of pocket delays from the input of the reject receiver to 
the actuation of the reject solenoid. 
 
Array Fault Receiver Shifts (0-29): The length of this reject shift 
register can be set to any value from 0 to 29 and is used to establish 
the number of pocket delays from the input of the array head fault 
receiver to the actuation of the reject solenoid. 
 
Aux1 Reject Input Shifts (0-29): The length of this reject shift 
register can be set to any value from 0 to 29 and is used to establish 
the number of pocket delays from the input of the Aux1 (vision) 
Reject to the actuation of the reject solenoid. 
 
Aux2 Reject Input Shifts (0-29): The length of this reject shift 
register can be set to any value from 0 to 29 and is used to establish 
the number of pocket delays from the input of the Aux2 Reject to the 
actuation of the reject solenoid. 
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________________________________________________________ 
3.5.3 ZERO MACHINE (SET RESOLVER OFFSET)  
 
When a resolver is used for machine timing, the M4500 internally 
generates the Clock timing (one pulse per pocket) and the Reset 
timing (one pulse per revolution of the main carrier wheel). This 
selection is used to auto zero the resolver. To set the machine zero 
(resolver offset) perform the following: 
 
1) Time the resolver by rotating the machine forward until a reject 

from pocket 1 will activate the Odd reject solenoid. This is the 
resolver zero position. 

 
2) Auto zero the resolver by selecting "3: ZERO MACHINE (SET 

RESOLVER OFFSET)" from the primary setup menu. Enter "0" 
to zero the resolver. The critical inputs positions will be displayed, 
now showing the "POS 360:" and the “ABSOLUTE POS:” at 
zero. 

 
3) Exit back to the primary setup menu by pressing <ESC>. Pressing 

<ESC> again will return to the main display. 
 
 
________________________________________________________ 
3.5.4 VIEW CRITICAL INPUT POSITIONS 
 
The “View Critical Input Positions” display is used to view the 
position, in degrees (360 degrees pocket-to-pocket reference), that the 
Reject Receiver, Array Fault Receiver, Aux1 (vision) Reject, and 
Aux2 Reject signals are coming in at. Primarily this is to verify that 
none of these signals coincident with the “Clock” timing. If a signal is 
very close or coincident with the “Clock” timing, the system could 
potentially miss clock the reject signals, causing the wrong can to be 
intermittently rejected. This display also shows the absolute position 
of the resolver (at a scale factor of 3840 divisions per revolution). 
 
The “4: View Critical Input Positions” menu is accessed from the 
primary setup menu when the “SETUP” key has been depressed. 
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________________________________________________________ 
3.6 "TEST REJECT" KEY 
 
This key is used to test the reject solenoid while the machine is 
running (with cans) and when the machine is stopped. Testing the 
reject solenoids while the machine is running verifies the reject 
operation. When de-pressed, a single reject will be inserted into the 
leaker reject shift register. The reject solenoid is activated in the same 
way as when a leaker reject can is detected. 
 
With the machine stopped, de-pressing the "Test Reject" key will 
activate both reject solenoids as long as button is depressed. This is 
used to verify the actuation of the reject mechanism.  
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The Windows based setup program is menu driven, allowing the user 
to easily view data, alter setup variables or set machine timing, using a 
computer running the Windows (95/98/ME/2000/XP/NT) operating 
system. The setup variables are used to configure and tune the M4500 
to match the configuration and performance of the specific tester (see 
Setup Reference, section 2.9). 
 
Note:  The setup program is an on-line communications program 
used to interface with the M4500 and communicates directly while in 
the “Online” edit mode. Prior to going online, make sure an RS-232 
cable is connected from the COM port on the computer to the 
"PROG" port on the M4500.  The variables displayed while in the 
“Online” edit mode are read directly from the processor.  Data can be 
saved to a “Setup Data” file (*.sdt) whenever changes are made to the 
parameters or if the data is uploaded. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Setup Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current setup program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The setup program allows the user to make 
changes while “Online” with the processor.  The “Offline” mode is 
used to preset parameters prior to download.  All functions are 
available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed under the “Edit” menu. 
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Getting Help:  The entire contents of this manual is contained 
within the help file.  Pressing Ctrl+H will display the help file 
window.   
 

 
 
Pressing the F1 key will display the contents of the help file.   
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Hot spots allow jumps to other topics to display additional 
information as desired.   
 
Selecting About from the Help menu will display a dialog box listing 
information about the current revision of the setup program and how 
to obtain technical support. 
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________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” setup “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Export Shift Data to a Text File. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current setup “Data File” to the 

processor 
• Print a Report of the current setup parameters. 
• Exit the setup program 
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________________________________________________________ 
4.2.1 THE SETUP DATA FILE 
 
The setup “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the setup program is first invoked, the 
default setup parameters are loaded into memory.  If changes are made 
to any of the setup parameters (either online or offline), as well as 
shift data, the user will be flagged to “Save Changes” upon exit of the 
program. 
 
Note:  Any windows based “Setup” program can open a setup “Data 
File”, however, the data tables will not be properly aligned.  The user 
will be alerted to the problem if the setup data file was created by a 
different setup program or a different revision of the software. 
 
The setup “Data File” is similar to that of a word processing file.  
When the program first starts a default file is loaded and the user is 
able to make any changes as desired.  The setup program is unaware 
of the settings and parameters that exist within the M4500.  Therefore, 
to normalize the setup program with the processor, the user should 
define or open an existing file, then upload “All” variables from the 
processor.  This allows the user to either create a backup of the data or 
maintain an existing file.  The user can even open a data file for 
another tester, save the file to a new name, make the necessary 
changes and simply download the new parameters to another 
processor. 
 
The following functions can be accessed any time, from any setup or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes to the existing file. 
 
Open:  To “Open” an existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box allowing 
the user to select an existing data file to open. The name of the file 
will be displayed in the title bar.  If any changes were made to the 
existing file, the user will be prompted to save any changes before 
terminating the program. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  This displays a dialog box allowing the 
user to select a folder and enter a name for the file.  The user will be 
notified if the file already exists and the extension “.sdt” will 
automatically be added to the file name.  If this is a “New” file, the 
user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box allowing the user to 
select a folder and enter in a new name for the file.  The user will be 
notified if the file exists and the extension “.sdt” will automatically be 
added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
 
 
________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Setup” program allows the user to upload setup parameters and 
shift data from the M4500 into a setup “Data File”.  This function is 
accessed from the “File” menu. 
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________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Setup” program allows the user to “Download” any SYSdev 
program file to the M4500. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the setup program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid SYSdev file can be 
downloaded using the setup program. Care should be taken when 
selecting a program to download. 
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Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.  The user must 
confirm their selection by clicking the “Yes” command button.   
 

 
 
After the user confirms their choice, program download is initiated 
and the current program download address is displayed.  When 
program download is complete, the user is prompted to acknowledge.  
Control is passed back to the main program and the setup program 
remains in an “Online” edit mode. 
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________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The setup program allows the user to download  “Setup” parameters 
and shift data to the M4500 from the setup “Data File”.  This function 
is accessed from the “File” menu. 
 

 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
 
 
________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Setup” program allows the user to generate a “Report” printout 
of all the setup parameters and shift data.  This function is accessed 
from the “File” menu. 
 
At the top of each page, the report displays the name of the setup file 
being printed.  At the bottom of each page is the date and time the 
document was printed, as well as, the page number. 
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To printout a report of the settings contained in the setup “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  

This displays the “Print Setup” dialog box, allowing the user to 
select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the 
specified printer device.  This function makes use of the windows 
print manager, which allows the user to continue with their work 
while the document is being printed. 

 
 
________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Setup the Comm Port. 
• Setup Passcode 
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________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded setup data.  This allows the user the ability to make 
any necessary changes to the setup parameters while not online with 
the processor.   
 
If offline editing is not enabled, the user is only able to view the setup 
parameters and shift data.  When the program is first invoked, the 
default setting is offline editing disabled.  The user will need to 
specifically select “Enable Offline Editing” from the edit menu (or 
press function key F2) to enable/disable this feature. 
 
 
________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications 
port and rate to talk to the M4500.  The programming port of the 
M4500 is set to 9600 baud. 
 

 
 
Once selected, a dialog box requesting the user to select a “Comm 
Port” and “Baud Rate” will be displayed.  The default setting is 
COM1 at 9600 baud.  The option to select the 19200 baud rate is to 
allow the user to communicate with the processor via the S4516 serial 
communications board. 
 
In most cases the user will only need to specify the communications 
port and leave the baud rate at 9600.  If communication problems 
occur, make sure there is a secure connection from the PC to the PLC.  
Then check the Comm port.  In most cases the user will only need to 
select a new Comm port.  If communication problems persist there 
may be another program causing a conflict with the port.  Check the 
port configuration from the Windows “Settings” folder. 
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________________________________________________________ 
4.3.3 EDIT SETUP PASSCODE 
 
The edit “Setup Passcode” is an “Online” function only.  This allows 
the user the ability to directly change the value of the Keypad/Display 
“Setup Passcode”. 
 
Once selected, an input box is displayed, allowing the user to view the 
current “Passcode” setting and to change the value if necessary.   
 

 
 
If the passcode is set to zero, passcode entry is disabled.  The operator 
can press the Setup key on the Keypad/Display and simply press the 
<ENTER> key to gain access to the setup parameters without having 
to enter a zero.  
 
If the value of the “Setup Passcode” is set somewhere between 1 and 
65,000, “Passcode Entry” is enabled.  This requires the operator to 
enter in the “Correct” passcode to gain access to the setup parameters. 
 
If an invalid value is entered, the passcode value will not be reset and 
a message box notifying the user of the error is displayed. 
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed from the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the setup program will prompt the user to select a 
program to compare with the one existing in the processor.  Whether a 
program is selected or the user cancels, the setup program will attempt 
to communicate with the M4500.  If unsuccessful a warning message 
will be displayed, prompting the user to either “Retry” or “Cancel” the 
operation.  If the operation is canceled and communication with the 
processor cannot be established the system will be placed in an 
“Offline” mode, however the “Target Board Interface” window will 
be displayed. 
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________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the setup program in an 
“Online” mode with the processor.  This is accessed from the “View” 
menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the setup program will attempt to open the Comm port 
and communicate with the M4500.  If the setup program is 
unsuccessful, a warning message will be displayed prompting the user 
to either “Retry” or “Cancel” the operation.  If the operation is 
canceled and communication with the processor cannot be established 
the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the setup program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed, prompting the user to either “Retry” or “Cancel” the 
operation. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the setup program in an 
“Offline” mode.  This is accessed by the “View” menu by selecting 
“Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in 
“Offline” edit mode reflect the actual values contained in the currently 
loaded setup data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the setup program will close the Comm port and cease 
communication with the M4500. 
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________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of six different 
Display/Setup windows to modify setup parameters, view shift data or 
receive feedback about the current status of the control system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item and the selected window is displayed and the name 
is changed in the title bar of the main window. 

 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the 
control system.  This window is selected from the “Window” menu. 
 

 
 
The following is a list of the functions of the “Main Display” window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4500, as well as, 
the current “Online” or “Offline” status of the setup program.  By 
simply scrolling the display, the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine CPM:  This display is only active while “Online” and 
displays the current speed of the machine in “Cans Per Minute”. 
 
Good Cans: This is the total number of good cans tested so far into 
the shift. This is essentially a can counter. 
 
Leaker Rejects: This is the total number of “Leaker” cans rejected 
from the machine by the “Reject Receiver” input (IN0) so far into the 
current shift. 
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Vision Rejects: This is the total number of cans rejected from the 
machine by the “Aux1” or “Vision” reject input (B100.2) so far into 
the current shift (if used). 
 
Total Rejects: This is the summation of the total number of cans 
rejected from the machine due to the “Reject” receiver”, “Array Fault” 
receiver, “Aux1” (vision) or “Aux2 reject inputs. 
 
%Scrap (total): This is the percentage of all cans tested that were 
rejected from the machine. 
 
%Scrap (leaker): This is the percentage of all cans tested that were 
rejected due to a “Reject Receiver” reject signal. 
 
%Scrap (vision): This is the percentage of all cans tested that were 
rejected due to a “Aux1” or vision reject signal. 
 
 
________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Setup Parameters” window is used to view and adjust any of the 
setup parameters.  This is selected from the “Window” menu. 
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Machine Configuration: 
 
1) Machine Number of Pockets (8 - 16): This parameter is used 

to set the number of pockets of the machine (8, 10, 12 and 16). Set 
this value to the number of pockets for the machine. 

 
2) Resolver Input Enable: This parameter is used to enable the 

use of the resolver feedback for all timing functions. Enabling this 
feature allows other displays to be active as well as disable the 
“Clock” and “Reset” timing inputs. Select the check box when a 
resolver is used for machine timing. 

 
Reject Shift Registers: 
 
1) Pocket #1 Offset: This is adjusted such that a reject from 

pocket #1 is counted as a reject from pocket #1. Covering the 
“Array Reset” pickup (center window of array head) of array head 
number 1 with electrical tape will create a consistent reject from 
the array head. Run cans through the machine and observe the 
pocket number of the “Rejected Pocket” display field. Adjust the 
“Pocket #1 Offset” until rejects for the associated array head 
continuously increment. 

 
2) Array Head Fault Offset: This number is used to correctly 

display the number of the “Faulted Array Head” when a “Leak 
Detection Array Fault” occurs. Using electrical tape, cover the 
“Reject” IR output of array an array head. This will cause an 
“Array Head Fault” to be generated on the particular pocket. 
Adjust this offset until the faulted array head is correctly displayed 
when the fault is generated.  

 
3) Reject Receiver Shifts (0-29): The length of this reject shift 

register can be set to any value from 0 to 29 and is used to 
establish the number of pocket delays from the input of the reject 
receiver (IN0) to the actuation of the reject solenoid.  

 
4) Array Fault Receiver Shifts (0-29): The length of this reject 

shift register can be set to any value from 0 to 29 and is used to 
establish the number of pocket delays from the input of the array 
head fault receiver (N1) to the actuation of the reject solenoid.  
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5) Aux1 Reject Shifts (0-29): The length of this reject shift 
register can be set to any value from 0 to 29 and is used to 
establish the number of pocket delays from the input of the Aux1 
(vision – B100.2) Reject to the actuation of the reject solenoid. 

 
6) Aux2 Reject Shifts (0-29): The length of this reject shift 

register can be set to any value from 0 to 29 and is used to 
establish the number of pocket delays from the input of the Aux2 
Reject to the actuation of the reject solenoid.  

 
Absolute Position: 
This display shows the absolute position of the resolver in counts with 
a scale factor of 3840 divisions per revolution. This display is only 
active when the Resolver Feedback Enable option has been selected. 
 
Zero Resolver: 
When a resolver is used for machine timing, the M4500 internally 
generates the Clock timing (one pulse per pocket) and the Reset 
timing (one pulse per revolution of the main carrier wheel). This 
selection is used to auto zero the resolver.  
 
Note: This selection is only active when the Resolver Feedback 
Enable option has been selected. 
 
To set the machine zero (set resolver offset) perform the following: 
1) Time the resolver by rotating the machine forward until a reject 

from pocket 1 will activate the Odd reject solenoid. This is the 
resolver zero position. 

 
2) Auto zero the resolver by clicking on the “Zero Resolver” button. 

A dialog box will appear asking to confirm the operation. Select 
“Yes” to zero the resolver. The Absolute Position and Machine 
Position will show the position at zero. 

 
Machine Position: 
This display shows the relative position of the machine (360 degree 
pocket-to-pocket reference). This is a calculated value based on the 
number of pockets and the absolute position of the machine. This 
display is only active when the Resolver Feedback Enable option has 
been selected.    
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________________________________________________________ 
4.5.3 THE SERIAL COMMUNICATIONS WINDOW 
 
The Serial Communications window is used to view the status of the 
S4516 serial communications board (if installed), as well as, view the 
status of the Allen-Bradley DF1 communication. From this window 
the user can view the following: 
 
• View the S4516 configuration status. 
• View the S4516-DF1 serial communication status. 
• View the Allen-Bradley Link Layer serial communication status. 
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1) S4516 Configuration Status:  This displays the current state 
of the configuration of the S4516 serial communications board.  
System function sfunc19(); (S4516 configuration) is used to set 
the S4516 configuration (network node address, network baud rate 
and USER port baud rate).  This must be executed prior to 
executing ether system functions 10, 11 or 13.  System function 19 
is executed in the “Initialization” file of the user program, as well 
as in the main program to re-initialize the S4516 whenever it 
detects a loss of communications with the host PLC. 

 
 The following values are returned from a system function 19 call: 
 1 = Busy. 
 2 = Done (S4516 Successfully configured). 
 3 = Invalid Parameter (either network node address, network 

baud rate or USER port baud rate is invalid). 
 4 = Timeout (no response form S4516) 
 32 = Hardware ACK error from S4516 
 34 = Invalid S4516 Slot Address (W8156 must be loaded with 

the slot address of the S4516, prior to executing system 
function 19). 

 
2) Transmit Data Status:  This represents the state of the data 

packet transmission and will typically display either “Busy” or 
“Done”.  If there are problems delivering the message packet, the 
response code, along with a description, will be displayed. 

 
Note:  The “Transmit Data Status (prev.)” is used to view the last 
or previous status. 

 
3) Current Transaction:  This is the “Transaction” number 

delivered to the Allen-Bradley PLC. 
 
4) Active Command:  This displays either “Read” or “Write”.  

This is used to view the command type of the current transaction. 
 
5) Number of  BYTES Received:  This displays the current 

number of bytes received from either a “Command” or “Reply” 
message packet. 

 
6) Received Command BIT Status:  This displays the state of 

the command received.  If this displays a “Reply”, then the 
command was sent from the M4500.  If this displays “Command”, 
then a command action was received by the M4500. 
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7) A/B Link Layer Status:  This displays the status of the receipt 
of the message packet sent to the Allen-Bradley PLC.  If the 
delivery is not successful, an error code along with a description is 
displayed.  Refer the to the Allen-Bradley Communication 
Protocol and Command Set reference manual for more 
information on “Link Layer” error codes. 

 
8) A/B Link Layer – Current Transaction Received:  This is 

the “Transaction” number received from the Allen-Bradley PLC. 
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________________________________________________________ 
4.5.4 THE SHIFT DATA WINDOW 
 
The “Shift Data” window is used to view the shift data collected by 
the M4500.  This window is selected from the “Window” menu. 
 

 
 
This window utilizes a “TAB” control to divide the shift data into 
three categories, similar to that of the Keypad/Display.  These sections 
are as follows: 
 
Rejects Per Pocket: 
The number of rejects per pocket menu is provided to aid in the 
trouble-shooting of a light seal problem with a pocket or pockets. The 
total number of rejects for each pocket since the last reset or end of 
shift is displayed. 
 
Note:  Prior to selecting this selection, make sure the RS-232 cable is 
connected from the COM port on the computer to the "PROG" port of 
the M4500. 
 
1) Rejected Pocket:  This is the number of the last pocket that 

generated a leaker reject.  This is only available in the online 
mode. 
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2) Rejects Per Pocket #:  This is the total number of leaker 
rejects for each pocket. This data is displayed and updated 
continuously in the respective field for each pocket. A 
disproportionately high count for a particular pocket indicates a 
light seal problem for that pocket. 

 
3) Reset Rejects:  This provides the operator the opportunity to 

reset the counts for troubleshooting purposes.  Resetting these 
counts does not affect the total number of rejects per for the shift.  
This function is only available in the online mode. 

 
 
Current Shift: 
This selection is used to view the Current Shift data. This data is the 
totals so far into the shift. This data is transferred to the "Last shift" 
data when the end of shift input transfers from a "0" to a "1". This can 
be at the end of either an 8 or 12 hour shift or alternatively could be 
done at label changes such that the data collected would be for label 
runs rather than complete shifts.  
 

 
 
Note:  Prior to selecting this selection, make sure the RS-232 cable is 
connected from the COM port on the computer to the PROG PORT 
on the M4500. The following data is displayed in the "Current Shift 
(Totals so far)" menu: 
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1) End of Shift - Transfer Data: This button is used to invoke an 
end of shift data transfer.  This will cause the current shift data to 
be transferred to the last shift and then all counts reset to zero. 

 
2) Total Good Cans Tested: This is the total number of good 

cans tested so far into the shift. This is essentially a can counter. 
 
3) Total Rejects: This is the total number of cans rejected by the 

machine so far into the shift. 
 
4) Leaker Rejects: This is total number of “Leaker” cans rejected 

from the machine for the shift. 
 
5) Array Faults: This is the total number of “Array Faults” that 

have occurred for the shift. 
 
6) Aux1 (Vision) Rejects: This is the total number of cans 

rejected due to an Aux1 (vision system) reject input for the shift. 
 
7) Aux2 Rejects: This is the total number of cans rejected due to 

an Aux2 (if used) reject input for the shift. 
 
8) Rejects Per Pocket: This is the total leaker rejects for each 

pocket. A disproportionately high count for a particular pocket 
indicates a light seal problem for that pocket. 
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Last Shift: 
The "Last Shift" data is identical to the current shift data except it is 
the totals for the previous 8 or 12 hour shift or previous label run, how 
ever the shift collection is setup. This allows data collection and 
diagnostics to take place automatically over a two shift period. Refer 
to the previous section for definitions of the data fields in the "Last 
Shift" data menu. 
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________________________________________________________ 
4.5.5 THE CRITICAL INPUT POSITIONS WINDOW 
 
The critical input positions window is used to view the position, in 
degrees (pocket-to-pocket), that the Reject Receiver, Array Fault 
Receiver, Aux1 (vision), and Aux2 reject signals are coming in at 
while the machine is running. Primarily this is to verify that none of 
these signals are coming in within +/-60 degrees of the “Clock” 
timing. If any of them do, the system could potentially miss clock the 
reject causing the wrong can to be intermittently rejected. 
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________________________________________________________ 
4.5.6 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs, 
outputs and that of the M4500.  This includes the interrupt inputs (IN0 
and IN1), the analog I/O, the resolver and I/O boards.  These values 
are displayed as read by the M4500 processor 
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The following is provided as a quick reference to aid in the trouble-
shooting of the RTM-LT16. Definitions and causes of the various 
alarm messages displayed by the RTMLT16 module is provided as 
well as a general step-by-step trouble-shooting process. 
 
 
________________________________________________________ 
5.1 ALARM MESSAGE DEFINITIONS 
 
In addition to the default and setup messages described in previous 
sections, alarm and status messages are displayed and defined as 
follows: 
 
"Leak Detector Array Fault": At the leading edge transition of the 
Clock timing input, a check is done to verify the transition of state of 
the Array Fault receiver. If a transition of state was not detected, a 
“Leak Detection Array Head Fault” is generated, the “Array Head 
Fault” output is turned ON and reject information is shifted into a 
reject shift register to activate the appropriate reject solenoid and 
reject the associated can. 
 
"Reset Timing Flag Failure": At the leading edge transition of the 
Clock timing input, a check is made to verify the occurrence of the 
Reset timing input and to increment the current pocket count. If the 
current pocket count exceeds the number of pockets of the machine 
then a Reset Timing Fault is generated. 
 
"Clock Timing Flag Failure": After the machine starts and the 
Machine Run input is ON, the system will periodically check for the 
occurrence of the Clock timing input approximately every 1.5 
seconds. If this input fails to change state then a Clock Timing Fault is 
generated.  
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________________________________________________________ 
5.2 CAN REJECT TROUBLE-SHOOTING 
 
If the system is intermittently rejecting the wrong can perform the 
following to trouble-shoot the system: 
 
Note: The function of the reject solenoids can be performed at full 
production speeds using the “Test Reject” key on the Keypad/Display. 
Depressing this will cause one can to be rejected just as a normal 
reject would occur. This key can also be pressed with the machine 
stopped to verify the operation of the reject solenoids and will be ON 
as long as the key is pressed. 
 
1) With the machine stopped, verify the operation of both reject 

solenoids. Remove an airline or disconnect the output to one of 
the solenoids then press the “Test Reject” key to verify operation. 
Repeat for the second solenoid 

 
2) Verify air pressure to reject solenoids. 
 
3) Verify wiring and function of Reject receiver. With an array head 

exposed to ambient light, the output should be ON. As the array 
head passes the Reject receiver, input IN0 should also turn ON. 
Verify that the input turns ON for all array heads. This same 
function should be true for the Array Fault receiver as well. 

 
4) When a shaft mounted resolver is not installed, the Clock and 

Reset timing inputs are either derived from a two channel shaft 
encoder driven off the main carrier wheel or from sensors located 
inside the machine. The Clock timing occurs once per pocket. The 
Reset timing occurs once per revolution of the main carrier wheel, 
in between Clock timing pulses and determines the location of 
pocket 1. 

 
Verify that as the machine is rotated in the forward direction, the 
input for the Clock timing (B100.0) comes ON once per pocket 
and the input for the Reset timing (B100.1) comes ON once per 
revolution of the main carrier wheel. 

 
5) If a shaft mounted resolver is installed, check the resolver 

mounting and coupler for obvious damage (broken or loose 
coupler or mount). 
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6) Position the machine at machine zero (see section 2.9.2). From the 
“View Critical Input Positions” selection of the primary setup 
menu, verify that the “Absolute POS:” reads 0000. If not re-zero 
the resolver. 

 
7) Verify 360 degrees pocket-to-pocket. With the machine at 0 

degrees, move the machine forward by hand one pocket. The 
“POS 360:” should count up thru 359 and again be at 0 degrees. 
Do this for all the pockets.  

 
Note: The “POS 360:” may deviate +/-20 degrees from pocket to 
pocket. This is normal and is not a problem. If it does deviate 
significantly more than +/-20 degrees, perform the following: 

 
a) Using a DVM in AC mode, measure the voltage between R1 

and R2 at the M4500 resolver connector. This should read 1.0 
to 1.5 VRMS (AC voltage). If no voltage is read, replace the 
M4500 (see section 2.10.2). Be sure the DVM is in AC mode, 
this is not a DC voltage. 

 
b) Again using the DVM in AC mode, verify the voltage between 

S1 and S3 at the resolver connector while slowly rotating the 
machine forward one revolution. The voltage should vary 
between 0 and 2.0 VRMS. If the voltage always stays at zero 
as the machine is moved forward, check the resolver wiring 
for a loose connection. If the wiring is OK, replace the 
resolver. 

 
c) Check the voltage between S2 and S4 at the resolver connector 

just as was done for S1 and S3 above. It should read just as S1 
and S3 should read. 

 
d) If steps (a) thru (c) above check out OK, check the resolver 

coupler. Make sure the key in the resolver shaft is installed and 
the coupler is tight. 

 
e) If (a) thru (d) did check out OK, but the pocket-to-pocket 

“Zero” location is still not right, replace the resolver. 
 
8) With the machine running in normal production, verify the input 

positions of the critical inputs. These include the Reject Receiver, 
Array Fault Receiver, Aux1 (vision), and Aux2 reject signals. 
These signals should NOT be close or coincident with the “Clock” 
timing. 
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9) If after performing the previous steps (1) thru (8), the system is 

still not functioning correctly, perform all the steps of the setup 
section 2.4. 

 
10) If after performing step (9) and the system is still not functioning 

correctly, replace the M4500 then try again. See section 2.10.2 for 
details on replacing the module. 
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The following are recommended spares for the RTM-LT16. 
These parts are available through Systems Engineering 
Assoc. Inc. 
 
 
Quantity Part Number Description 
 
 1ea. M4500 PLC/PLS 

Processor/Chassis  
   (4-Slot) Module 
 1ea. P4500 +5VDC, +/-12VDC 

Power Supply - (M4500) 
 1ea. D4591 2 Line X 40 Character 

Display/24 Key Operator 
Interface 

 1ea. S4569 4-Diff In/4-BiDir/4-Out 
(Sink) 10-30VDC I/O 
Board 

 1ea. RSV34-MS1 Resolver with MS 
Connector 
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________________________________________________________ 
HARDWARE 
 
DF1 communication takes place via the Channel 0 port of the Allen 
Bradley PLC. The RS-232 cable should be constructed and connected 
as shown below: 
 
S4516-DF1 to PLC5 
 

 
Internally, the PLC-5 should be set up for RS-232C communication. 
Refer to the dip-switch settings guide on the side of the processor. 
 
Note: The S4516-DF1 should be switched for RS-232 
communication.   
 
Dip switch SW1 is the RS-232/RS-422 dip switch should be set to:  
 POLE 1 = ON  
 POLE 2 = OFF 
 
Dip switch SW2 is the slot address, and is dependent upon the rest of 
the cards in the M4500 rack and should be set to: 
 POLE 1 = ON  
 POLE 2 = ON 
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S4516-DF1 to SLC 
 

 
 
S4516-DF1 to ControLogix 
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________________________________________________________ 
SOFTWARE 
 
PLC5 
The following sample RSLogix5 code is used to execute the message 
control function to allow a PLC5 processor to communicate with the 
S4516-DF1 serial communications board. 
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SLC500 
The following sample RSLogix500 code is used to execute the 
message control function to allow a SLC500 processor to 
communicate with the S4516-DF1 serial communications board. 
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ControlLogix and CompactLogix 
The following sample RSLogix5000 code is used to execute the 
message control function to allow a ControLogix or CompactLogix 
processor to communicate with the S4516-DF1 serial communications 
board. 
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________________________________________________________ 
USING THE MSG INSTRUCTION 
 
READ INSTRUCTION – PLC5 
The read message (MSG) command for a PLC5 is setup as follows: 
 

 
 
 
Note:  The Communication Command is “SLC Typed Logical Read”.  
The Data Table Address can be any integer file address.  The 45 
elements (total) read from the M4500 PLC are defined in the last 
section – Read/Write Data Definitions. 
 
The Local Station Address is only necessary to define if 
communications with the S4516-DF1 is executed over a Data 
Highway network (via a DataLink Module). 
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WRITE INSTRUCTION – PLC5 
The write message (MSG) command for a PLC5 is setup as follows: 
 

 
 
 
Note:  The Communication Command is “SLC Typed Logical 
Write”.  The Data Table Address can be any integer file address.  The 
5 elements written to the M4500 PLC are defined in the last section – 
Read/Write Data Definitions. 
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READ INSTRUCTION – SLC500 
The read message (MSG) command for a SLC500 is setup as follows: 
 

 
 
 
 
Note:  The Data Table Address can be any integer file address.  The 
45 elements (total) read from the M4500 PLC are defined in the last 
section – Read/Write Data Definitions. 
 
The Local Station Address is only necessary to define if 
communications with the S4516-DF1 is executed over a Data 
Highway network (via a DataLink Module). 
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WRITE INSTRUCTION – SLC500 
The write message (MSG) command for a SLC500 is setup as 
follows: 
 

 
 
 
Note:  The Data Table Address can be any integer file address.  The 5 
elements written to the M4500 PLC are defined in the last section – 
Read/Write Data Definitions. 
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READ INSTRUCTION CONFIGURATION – CONTROLOGIX 
The read message (MSG) configuration for a ControLogix PLC is 
setup as follows: 
 

 
 
Note:  The “Message Type” is SLC Typed Read.  The Destination 
Element can be any integer array.  The 45 elements (total) read from 
the M4500 PLC are defined in the last section – Read/Write Data 
Definitions. 
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WRITE INSTRUCTION CONFIGURATION – CONTROLOGIX 
The write message (MSG) configuration for a ControLogix PLC is 
setup as follows: 
 

 
 
Note:  The “Message Type” is SLC Typed Write.  The Source 
Element can be any integer array.  The 5 elements written to the 
M4500 PLC are defined in the last section – Read/Write Data 
Definitions. 
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COMMUNICATION TAB - CONTROLOGIX 
The communication configuration for a ControLogix PLC is setup as 
follows: 
 

 
 
The “Path” describes the route the message takes to get to the 
destination. The format of the “Path” uses this format: 
port, next_address 
 
For serial DF1 communications, the port is “DF1 serial, channel 0” 
(Type = 2), next_address is for the station address (0-254). Since there 
is only the direct link from channel 0 to the User Port on the S4516-
DF1 board, the next_address is set for station 0. 
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TAG TAB - CONTROLOGIX 
The Tag configuration for a ControLogix PLC is setup as follows: 
 

 
 
Note:  The Tag “Data Type” must be MESSAGE and is defined at 
the “Controller” scope level.
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________________________________________________________ 
CHANNEL 0 SETUP 
 
PLC5 
The Channel 0 Serial Port should be setup as follows: 
 

 
 
Note:  The Communication Mode is setup for System (Point-to-
Point). 
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PLC5 
The Channel 0 Options are setup as follows: 
 

 
 
Note:  The “Detect Duplicate Messages” should be unchecked. 
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SLC500 
The Channel 0 Serial Port should be setup as follows: 

 
 
The Channel 0 Options are setup as follows: 

 
 
Note:  The “Duplicate Packet Detect” should be unchecked. 
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CONTROLOGIX 
The Serial Port (Channel 0) should be setup as follows: 
 

 
 
The “System Protocol” should be setup as follows: 

  
 
Note:  The “Enable Duplicate Detection” should be unchecked. 
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________________________________________________________ 
READ/WRITE DATA DEFINITIONS 
 
Data Read From The M4500 (45 Elements) Is Defined As Follows: 

 
 M4500 Mapped PLC  
Description Add Add Add Function 
General:     
M4500 Status Word 1 (to PLC)  W3910 N7:5 R/O 

Spare (Bit 00)  B3910.0 N7:5/0  
Spare (Bit 01)  B3910.1 N7:5/1  
Spare (Bit 02)  B3910.2 N7:5/2  

thru  thru thru  
Spare (Bit 14)  B3911.6 N7:5/14  
Spare (Bit 15)  B3911.7 N7:5/15  

     
M4500 Status Word 2 (to PLC)  W3912 N7:6 R/O 

Spare (Bit 00)  B3912.0 N7:6/0  
Spare (Bit 01)  B3912.1 N7:6/1  
Spare (Bit 02)  B3912.2 N7:6/2  
Spare (Bit 03)  B3912.3 N7:6/3  
Spare (Bit 04)  B3912.4 N7:6/4  

thru  Thru Thru  
Spare (Bit 14)  B3913.6 N7:6/14  
Spare (Bit 15)  B3913.7 N7:6/15  

     
M4500 Status Word 3 (to PLC)  W3914 N7:7 R/O 
Machine Speed (CPM) W556 W3916 N7:8 R/O 
     
Current Shift Data:     
Good Cans (Lo) W1100 W3918 N7:9 R/O 
Good Cans (Hi) W1102 W3920 N7:10 R/O 
Total Rejects (Lo) W1104 W3922 N7:11 R/O 
Total Rejects (Hi) W1106 W3924 N7:12 R/O 
Leaker Rejects W1108 W3926 N7:13 R/O 
Array Faults W1110 W3928 N7:14 R/O 
Aux1 (vision) Rejects W1112 W3930 N7:15 R/O 
Aux2 Rejects W1114 W3932 N7:16 R/O 
Rejects Per Pocket #1 W1116 W3934 N7:17 R/O 
Thru Thru Thru Thru  
Rejects Per Pocket #16 W1146 W3964 N7:32 R/O 
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 M4500 Mapped PLC  
Description Add Add Add Function 
Spare Registers:     
Spare  W3966 N7:33 R/O 
Spare  W3968 N7:34 R/O 
Spare  W3970 N7:35 R/O 
Spare  W3972 N7:36 R/O 
Spare  W3974 N7:37 R/O 
Spare  W3976 N7:38 R/O 
Spare  W3978 N7:39 R/O 
Spare  W3980 N7:40 R/O 
Spare  W3982 N7:41 R/O 
Spare  W3984 N7:42 R/O 
Spare  W3986 N7:43 R/O 
Spare  W3988 N7:44 R/O 
Spare  W3990 N7:45 R/O 
Spare  W3992 N7:46 R/O 
Spare  W3994 N7:47 R/O 
Spare  W3996 N7:48 R/O 
Spare  W3998 N7:49 R/O 

     

     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
 



APPENDIX A 
DF1 COMMUNICATIONS 

 
RTM-LT16 User’s Manual SYSTEMS Electronics Group 

 
- A-23 - 

Data Written To The M4500 (5 Elements) Is Defined As Follows: 
 
 M4500 Mapped PLC  
Description Add Add Add Function 
General:     
PLC Status Word 1 (from PLC)   W3900 N7:0 W/O 

End of Shift (Bit 00) F841 B3900.0 N7:0/0  
Spare (Bit 01)  B3900.1 N7:0/1  
Spare (Bit 02)  B3900.2 N7:0/2  
Spare (Bit 03)  B3900.3 N7:0/3  

thru  Thru Thru  
Spare (Bit 14)  B3901.6 N7:0/14  
Spare (Bit 15)  B3901.7 N7:0/15  

     
Spare  W3902 N7:1 W/O 
Spare  W3904 N7:2 W/O 
Spare  W3906 N7:3 W/O 
Spare  W3908 N7:4 W/O 
     
     
     
     
     
     
     
     
     
     
 
 


